©  ANSWER KEY

v

Trackpad ver 2.0

1. Fundamentals of Computer

.........

1. A microprocessor is an integrated chip on which the entire CPU (Control Unit and ALU) is
fabricated.

2. Digital Camera and Microwave.

1. a () b. (iv) c. (iv) e. (iii)
2. a.Plotter b. Computer ¢. Control Unit d. Optlcal Character Reader
e. Smart Watch
a. (F) b. (T) c.(T) d. (M) e. (F)

4. a. Magnetic Ink Character Reader is an input device that reads special characters that are
printed using a special magnetic ink on cheques like Cheque number, bank code and branch
code. MICRs scan this information and are thus capable of sorting cheques.

b. Barcode reader is an electronic device, used for reading printed barcodes. Barcode readers
consist of a light source, lens and light sensor that help them scan these codes.

c. Fourth Generation computers used components like the microprocessor, where micro refers
to the physical size of the component. A microprocessor is an integrated chip on which the
entire CPU (Control Unit and ALU) is fabricated.

d. A handheld computer is a type of computer that can easily be stored in our pocket and used
by holding it in our hands. Most of handheld computers have a touchscreen in which we
input data by using our fingers. Smartphone and Smartwatch are two examples of handheld
computer.
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e.

(i) A projector projects or displays data of computer screen on a large screen or surface for
audience.

(i) Automated Teller Machine (ATM) is another example of the embedded computer that
allows us to withdraw money from our bank account from anywhere and anytime.

(iii) The microwave that we use at our home is also an example of the embedded computer
that allows us to warm and cook food.

(iv) A laptop is a portable computer which you can keep on your lap. You can carry a laptop
anywhere, therefore, you are not restricted to one place while working on a desktop
computer.

Minicomputer

a. A supercomputer consists of a large a. Minicomputers are more powerful than
number of processors and also occupies microcomputers. They are bigger in size and

a huge amount of space.

faster in processing speed.

b. They are used in the fields of creating b. They can support several users working at the
animated graphics and conducting nuclear same time on the same machine which means
research. they support a multi-user environment.

c. For example. PARAM 9000

6.

7.
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c. For example HCL Magnum

a. Bar Code Reader

b. Laser printer

a.l b.1 c.O d. O
el f.O
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2. Formulas and Functions in Excel 2016

7’
{_/ iPage-28
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1. MAX(range) 2. Colon (), Single space and Comma (,).fabricated.

a. (ii) b. (i) c. (i) d. (i) e. (iv)
2. a. label b. equal to c. cell reference d. function e. LEN

3. a. A formula is an expression that operates on the value or a range of cells and generates a
result.

b. The results of the formula in a numerical formula, are calculated according to an order is
known as the operator precedence.

¢. The syntax of this function is CONCATENATE (textl, text2). It is used to join together two or
more different text strings

d. A group of selected cells is called a cell range. The selected cells should be in continuation
to form a range. Cell range is used to perform a calculation on multiple cells.

To select a cell range using a mouse, click in the first cell from which you want to start the
range, then press and hold the left mouse button and drag the mouse diagonally to select
the desired range. Now release the mouse button.

Aa Aa
Meaning Tip to Correct

The function name is not recognised Check and correct the

#NAME? .
by Excel. function name.

Check and correct the cell
ranges.

#REF! The cell reference is not valid.

The formula or function contains Ensure there are no special
#NUM! symbols such as $ or % being

invalid numeric values. .
used with the number.
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4. a. Max(): It returns the largest value in the given range.

b. Today(): It returns the current date.

c¢. Len(): It returns the length of the text string.

i. TItrefersto the cell that is above or below
and left or right to a number of rows or

columns.

ii. Forexample, a formula (=A2*B2) placed
in cell C2 multiplies the values of cells A2
and B2. As we press the Enter key, the
result of the multiplication of values in
A2 and B2 is displayed in cell C2.

Absolute Cell Referencing

i. TItrefers to the reference in a formula remains
the same even if we copy and paste the
formula to a new location.

ii. For example, if we want the value of Al to
be constant, when multiplying it with cell of
column B, absolute referencing will be used.

6. a. Divide by Zero Error. She should not divide the number by 0.

b. She should use SUM() function.

{coDING Z@N=}

a. 50

b.3

2. a. =CONCATENATE("Good ", "Morning") Result: GoodMorning

b. =MIN(10,6,-2,0) Result: -2

3. Charts in Excel 2016
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Answer: Bar Chart
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1. a (i) b. (iii) c. (i) d. (iii) e. (ii)

2. a.Chart b. Pie ¢. Column d. Area e. Scatter
3. a(p b. (F) c. (M d. (T e. (F)

4. a. Data can be presented in an attractive way to attract the attention of readers.

b. Legend: It is a key which displays the symbols or colours used in the chart.
Chart Area: It includes all objects and elements of a chart.

c. A pie chart is shaped like a circle divided into slices, each slice showing the relative size of
each value. The pie chart only displays one data series in the form of comparative charts. It
is useful when you want to emphasise on a significant element.

d. To change the background of the chart, follow the given steps:
@ sSelect the chart.
@ Click on the Format tab.
@© Click on the Format Selection command.
@ Click on the Fill section.
@ Click on the Picture or texture fill option button.

e. Aline chart is a type of graph that displays continuous data at regular intervals. It is generally
used to highlight the changes that take place in a value through a specified period of time.
It is also known as a frequency polygon.

f. To change the chart type, follow the given steps:
@ Select the chart and click on Design tab.
@ Click on the Change Chart Type command.
9 Click on desired option (here we choose Line option).
@ Click on Line option.
The chart will change to Line Chart.
a. Column chart or bar chart b. Pie chart c. Area chart
6. a.60 b. December c. October

{CoDING ZONE=}

1. 27 2.15 3. (O
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Periodic Assessment-1
(Based on chapters 1 to 3)

1. a. Smart Watch is used as a computing device which you can wear on your wrist.

b. Barcode Reader is used for reading printed barcodes.

2. a4 b. 15 c.8 d.3
a. January b. October
4. a. Chart b. Scatter Plot Chart c. Today() d. ATM

e. Supercomputer

4. Introduction to Adobe Animate 2021

{_/ iPage-54

........

Answer: 1. PolyStar Tool

2. Shift key
1. a. (i) b. (i) c. (i) d. (ii) e. (i)
2. a. Animation b. Library c. Frames d. Sub-Selection e. Lasso

3. a. Stage, Work Area and Current Scene (any three).

b. It organises and controls a document's content in layers and frames. Like films, Animate
documents divide time lengths into frames. The timings of animations are adjusted in the
Timeline panel.

¢. To fill colours in a shape, follow the given steps:
@ Click on the Paint Bucket tool.
@ Click on the Fill Color button.
©® Select the desired colour.
@ Click inside the shape to fill colour.

-
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d. To draw a curved line, follow the given steps:
@ Click on the Pen tool.
@ Click on the stage area from where the curve has to begin. An anchor point is created.

® Position the mouse pointer and drag to set the slope of the curve. Now release the mouse
button.

e. To save an Animate file, follow the given steps:
@ Click on the File menu.
@ Click on the Save option.
® Choose the location where you wish to save the file.
O In the File name: box, type the file name.
@ Click on Save button.

f. (i) Line Tool: It is used to draw straight lines.
(ii) Eraser Tool: It erases the area over which we click and drag the Eraser Tool.
(iii) Selection Tool: It is used to select objects and also move them.
4. a. Adobe Animate 2021
b. Lasso Tool

c. Classic brush tool

{CoDING Z@N=}

1. aGills b. Sky
2. a. G100 b.D, W
3. 9

5. More on Adobe Animate 2021

/ {Page-61

Sae \
\

.........

Answer: Text tool
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1. a () b. (i) c. (i) . (iii) e. (iii)
2. a M b. (T) c. (T d. (F) e. (T

3. a..fla b. Lasso Tool c. Free Transformation Tool d. Ctrl+G
e. Text Tool

4. a. When text is added to Label Text, the text does not wrap. The width of the text box keeps
expanding. When text is added to Block Text, we specify a width and while typing the text, if
it reaches the end of the block, it wraps to start a new line and increases the depth of the box.

b. To select an object in rectangular form, follow the given steps:

© Click on Selection tool.

@ Place the mouse pointer and click and drag over the object you want to select.
c. To rotate the object, follow the given steps:

@ Select the object and click on the Free Transformation tool.

@ Move the mouse pointer just outside the corner of the object. The mouse pointer changes

tof.\:

® Click and drag to rotate.

d. Yes, it is possible to group different shapes together as one. To group the shapes, follow the
given steps:

@ Select all the shapes one by one by pressing and holding Ctrl key.
@ Click on the Modify menu.
© Select the Group option.

e. We can change the font face and font size of the text from Properties inspector. To do so,
follow these steps:

@ select the text.

@ Select the font face.
@ Select the font size.
@ Sselect the Fill option.
© Select the colour.

@ select spacing.

5. a. Free Transformation Tool b. Lasso Tool
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Periodic Assessment-2
(Based on chapters 4 & 5)

File Name Tab Menu Bar Workspace Menu

Library Tab

Properties Tab

Tools Panel ©. Current Scene

Work Area

Timeline Panel

2. 2_ Go to the Import option.
‘i Navigate to the location and select the image.
1_ Click on the File menu.
3_ Select the Import to Stage option.

3. a. It draws and paints brush like strokes. It lets you create special effects.
b. It is used to select irregular shaped pieces of an object.
c. It erases the area over which we click and drag the Eraser tool.

d. It is used to select partial objects.
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Test Sheet-1

(Based on chapters 1 to 5)

. (iii) b. (iv) c. (iii) d. (ii) e. (i)

. (ii)

. Control Unit b. Optical Character Reader c. function d. LEN()

. equals to f. Bar g. Bar

. (F) b. (T) c. (M d. (T e. (T

- (N

a. Barcode reader or barcode scanner is an electronic device, used for reading printed barcodes.

. The results of the formula in a numerical formula, are calculated according to an order is

known as the operator precedence. The order of precedence is as follows:
1. Colon (:), single space, comma (,)

2. Percentage (%)

3. Exponent (%)

4. Multiplication (*) and Division (/)

5. Addition (+) and Subtraction (-)

6. Comparison Operators (=, <, >, <=, >=, <>)

. A formula is an expression that operates on the value or a range of cells and generates a

result.

d. Any two components of Charts are:

Legend: It is a key which displays the symbols or colours used in the chart.

Chart Area: It includes all objects and elements of a chart.

. The Timeline Panel organises and controls a document’s content in layers and frames. Like

films, Animate documents divide time lengths into frames.

. The Selection tool allows us to select an object in a rectangular selection marquee by clicking

and dragging over the object.

. A handheld computer is a type of computer that can easily be stored in our pocket and used

by holding it in our hands. Most of handheld computers have a touchscreen in which we
input data by using our fingers. Smartphone and Smartwatch are two examples of handheld
computer.

. A group of selected cells is called a cell range. The selected cells should be in continuation

to form a range. Cell range is used to perform a calculation on multiple cells.

To select a cell range using a mouse, click in the first cell from which you want to start the
range, then press and hold the left mouse button and drag the mouse diagonally to select
the desired range. Now release the mouse button.

N
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c. To save an Animate file, follow the given steps:
@ Click on the File menu.
@ Click on the Save option.
® Choose the location where you wish to save the file.
@ In the File name: box, type the file name.
@ Click on Save button.
d. To change the background of the chart, follow the given steps:
@ Seclect the chart.
@ Click on the Format tab.
® Click on the Format Selection command.
@ Click on the Fill section.
@ Click on the Picture or texture fill option button.

e. To change the chart type, follow the given steps:
@ select the chart and click on Design tab.
@ Click on the Change Chart Type command.
® Click on desired option (here we choose Line option).
O Click on Line option.
The chart will change to Line Chart.

f. We can change the font face and font size of the text from Properties inspector. To do so,
follow these steps:

@ Select the text.

@ Select the font face.
© Select the font size.
O Select the Fill option.
@ Select the colour.

@O Select spacing.

6. Learn HTML5 and CSS3

4
{_/ iPage-78
N\

_________

Answer: Empty tags are self-contained. They have only an opening tag. For example: <BR>.
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a. (ii) b. (i) c. (iv) () e. (ii)
a. HTML b. Hypertext c. External d. Comments e. <BODY>
a. Notepad b. <P> c. Tim Berners Lee d. Cascading Style Sheets
a. Markup language is a computer language that uses specific codes for formatting the layout

and style of a text file. It is human-readable, which means that markup files use the standard
English language rather than the programming syntax.

b. HTML is not a case sensitive language.
c. <TAGNAME STYLE = "“PROPERTY1:VALUE; PROPERTY2:VALUE; PROPERTY3:VALUE;" >
d. Cascading Style Sheets or CSS are used to define styles for webpages.

An inline style is used to apply a unique style for a single element. Inline styles are added
directly to an HTML tag by using the style attribute with the tag. Syntax to use the style
attribute with a tag:

<TAGNAME STYLE = “PROPERTY:VALUE;">

e. The <HR> tag is used to divide the webpage into different sections by drawing a horizontal
line in the webpage. The thickness of the horizontal line is specified through the Size attribute
and the length is specified through the Width attribute in pixels or as a percentage.

For Example:
<!DOCTYPE HTML>
<HTML>
<HEAD>
<TITLE> HR Tag </Title>
</HEAD>
<BODY>

<p>This is the first paragraph of the tag. HTML is the standard markup
language for Web pages. </p>

<hr Size="10" width="80%" >

<p>This is the second paragraph of the tag.HTML is the standard markup
language for Web pages.</p>

<hr Size="”10" width="80%" color="grey”>

<hr Size="10"” width="80%" color="Red”>

</BODY>

</HTML>

N
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5.

b.

a.
b.
C.

Comments
Inline CSS

He can use <p> tag. The attribute of <p> tag to define some extra properties of this tag is
align.

{coDING Z©N=}

The opening <HTML> tag is missing.

The closing </BODY> and </HTML> tags are missing.

7. Formatting a Webpage

See

.......

........

Answer: text-align

1

a.

(i) b. (iii) c. (i) d. (iv) e. (i)
(iii)

. (F) b. (T) c. (M d. (T e. (F)
. Cascading Style Sheets (CSS) is a convenient method of styling the elements of a webpage.

It controls various elements like the colour, font, text size, etc. within a single page or the
entire website. CSS can also be used to change the look of any webpage elements such as
paragraphs, lists, backgrounds, etc.

. Text-indent is the option which is used for indentation in HTMLS5.
. It is used for specifying the repetition of an image on the webpage.

d. The margin property is used to set margins for any webpage element. The four sides used

with the margin property are: left, right, top and bottom. The value of sides can be measured
in pixels (for example: 20px, 30px, etc.) or as a percentage of the window.

. Every web page on a website can be linked to a single style sheet, hence, any change made to

the style sheet formatting affects every HTML document linked to the sheet. We can use a style
sheet as a template by storing all the information in one place and easily change the appearance
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of our site in one go, thus saving a lot of time in case your site has numerous pages.

f. i.  Background-color: It contains the name of the colour. It specifies the background colour
to be used on the webpage.

ii. Text transform: It specifies the transformation of text into uppercase, lowercase or title
case.

4. a. Margin property
b. By changing the CSS properties of the elements.

{coDING Z@&N=}

1

8. Internet Services

-~

.........

a. (iv) b. (iii) c. (i) d. (ii)
a. Instant Messaging b. Google Drive c. Blogging d. Internet Banking
a. Google Meet b. Flipkart c.iTunes d. Facebook Messenger

> w o

a. Zoom is used as a video conference application which is basically live meeting held between
two or more geographically separated people. Each participant requires a video camera, a
microphone, speakers and a high-speed Internet connection to transmit audio and video
data.

b. Instant messaging allows us to exchange messages (text, picture, etc.) between two or more
people at different locations connected to the Internet. It allows us to create a group that
may consist of friends, family or people at work, with whom we can chat privately.

¢. Online transactions can be made without going to the bank and at any time of the day.

d. The following points must be kept in mind while using the Internet services to stay safe and
secure:

-
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e Never share your personal information with anyone.

e Always set a strong password as it is difficult to guess thereby securing your accounts.
e Avoid using public Wi-Fi while accessing your accounts.

e Avoid opening an e-mail that is received from an unknown person or source.

e. A podcast is like an online on-demand radio show. It can be considered as a medium through
which recorded audio information is distributed over the Internet, unlike a radio show where
the show is broadcasted live. We can listen to these audio files whenever we want. You can
listen to podcasts directly from the websites they are posted on or can also subscribe to them
using software like iPodder and iTunes.

5. a. File sharing service of Internet using Google drive or dropbox

b. E-commerce

{coDING Z®N=}

48
2. ABCDEF
Periodic Assessment-3
(Based on chapters 6 to 8)
1. a. Color b. background-color c. text-align

d. Hypertext e. <Title>
2. <!DOCTYPE html>
<html>
<head>
<title>Solar System</title>
</head>
<body>
<hl style="color: red; text-align: center; text-decoration:
underline;">Solar System</hl>
<p><i><b>The Solar System is the gravitationally bound system of the
Sun and the objects that orbit it, either directly or indirectly.</
b></i></p>
</body>
</html>
3. a. Video Conference: Video conference is a live meeting held between two or more
geographically separated people. Each participant requires a video camera, a microphone,
speakers and a high-speed Internet connection to transmit audio and video data.

) W

P
Trackpad (Version 2.0)-VI (Answer Key) ¢ 15
<



b. Google Drive: Google Drive is a cloud storage service developed by Google. It provides up
to 15 GB free safe storage space. We can store data online so that it can be accessed from
anywhere. It also provides tools for sharing with other users easily over the Internet.

c. Instant Messaging: Instant messaging allows us to exchange messages (text, picture, etc.)
between two or more people at different locations connected to the Internet. It allows us to
create a group that may consist of friends, family or people at work, with whom we can chat
privately.

9. Algorithm, Flowchart and Mind Maps

..........

{_/ ipage-110

S \
N

_________

Answer: Low-level language

-—m-i-

a. (This question was printed incorrectly in the book. Please correct it in your textbook.)

Question: a. Which shape is used to denote the processing of input in flowchart?

(i) Parallelogram (ii) Circle
(iii) Triangle (iv) Both (i) & (ii)
Answer: (i)
b. (iii) c. (i) d. (i)
2. a(F b. (F) c. (F) d. (F) e. (F)

3. a. Aflowchart is the graphical representation of a process and the logic (which is also called an
algorithm) used in it. Flowcharts are used in analysing, designing, documenting or managing
a process or program in various fields.
b. Definiteness: All instructions given should be clear and easy to understand.
Finiteness: It should include a finite number of instructions for completing a task.
(Any 2)

c. High-level language is considered to be closer to human beings. It is machine independent.
However, they need to be translated into binary or machine language. Some examples are
PASCAL, FORTRAN, etc.

d. An interpreter reads one line of instruction at a time and translates it into machine language.

-
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4.

A compiler reads an entire set of instructions written in a high-level language and then
translates them into machine language.

e. Any three symbols of flow chart are:
a
Description

D Input/Output: It represents reading input or writing output.

Processing: It indicates the processing of the input provided.

Decision: If there is a choice to be made between two options, this
symbol is used. It has two flow lines outwards, representing Yes or
No and True or False.

a. Loop b. Algorithm

{coDING Z@N=}

Following is an algorithm to accept the age of a person and check whether he/she is eligible to vote
or not. A person can only vote if he/she is 18 years old or more. Number the steps of the algorithm
in the correct order.

Accept the age of the person. Stop.

If age is greater than or equal to 18, then display, ‘You are eligible to vote'.

Start.

If age is less than 18, then display, ‘You are not eligible to vote'.

10. Introduction to Python

..........

-~

._/ i{Page-120

_________

Answer: 1. T 2.F
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a. (iv) b. (i) c. (i) d. (iii) e. (ii)

a. data type b. string c. input() d. Guido van Rossum

e. Interactive Mode

a. Python is a high level object-oriented programming language. It is a general purpose language
with interactive features.

b. Comments in Python can be used to explain parts of the code. It can also be used to hide
the code as well. Python does not execute comments.

0O

. A data type is used to define the type of value a variable can contain. For example, a person’s
name must be stored as a string value whereas the person’s age must be stored as an integer.

d. Operators are the special symbols which are used to perform computations. The values which
the operators use to get the output are called operands.

e. Output: 5
f. Output: Hello! How are you?

g. A Variable is the name of memory location that is used to store data values which can be
accessed or changed later. The names given to the variables are known as identifiers.

In Python, variables are declared and initialized at the same time in the following way:
a = 10
b = 20
print (“a=", a)
print (“b=", b)
On the output screen, a = 10andb = 20 will be printed.
h. To run a Python program, follow the given steps:
@ Click on the run menu.

@ Click on the Run Module option.

Script Mode

It is also known as IDLE Shell Window. i. It is also known as Editor's Window.

ii. It does not allow you to save our commands
written on the command prompt, it gives
output immediately after pressing the Enter
key.

It is an interactive window where we can
type a Python code and view the output
in the same window.

18 STrackpad (Version 2.0)-VI (Answer Key)
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Print() Function

i. We use input() function to take the user's i. We use the print() function to display the result
input while a program executes. on the screen.

ii. The general syntax of the input() function

ic 2 follows: ii. The general syntax of the print() function is

as follows:
Variable_name = input(<message to be

displayed>) type print(“message to be displayed”)

a. Script mode(Editor's window).
b. Press F5 key or goto Run = Run Module.
a. 461 b.7.0 . 32782 d. 113 e. 1662

{CcoDING Z@N=}

Error: Integers and strings cannot be directly added
Correct Code:

a=10
b=20
c=a+b+34
print(c)

Output: 64

Error: Comma is missing and the subtraction sign should be replaced with + sign
Correct Code:

a = "Divya"

b = "Sharma"

print("Result of + operator is: ", a + b)
Output: Result of + operator is: DivyaSharma
Error: Missing commas for separate printing
Correct Code:

a, b=10,20

c=a+a+b+a+b

print("ais:", a, "b is:", b, "cis:", )

Output: ais: 10 bis: 20 cis: 70

No errors

Output: False
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AR
Trackpad (Version 2.0)-VI (Answer Key) ¢ 19

<



11. Intelligence and Al Approaches

{_/ipage-131

Sae \

........

Answer: People who possess good understanding of musical rhythm and good at recognising the
musical patterns and tones easily.

a. (iii) b. (ii) c. (i) d. (ii)

a. (T b. (F) c. (M d. (T

a. Bodily-Kinesthetic Intelligence is being good at dancing and sports along with love creating
things with their hands, tends to remember by doing, rather than hearing and seeing, and
excellent hand-eye and physical coordination, flexible in different body movements and
performing actions.

b. A rule-based system uses rules as knowledge representation. These rules are coded in the
system in the form of if-then-else statements which help the computer in taking decisions. The
idea behind a rule-based system is to use the knowledge of a human expert in a specialised
domain and embody it within the computer system.

c. Intelligence refers to the ability to think, to learn from previous experience, to solve complex
problems and to adapt new things and environment.

Types of Intelligence:
e Virtual-Spatial Intelligence
e Verbal-Linguistics Intelligence
e Logical-Mathematical Intelligence
e Bodily-Kinesthetics Intelligence
e Musical Intelligence
e Interpersonal Intelligence
e Existential Intelligence
e Intrapersonal Intelligence
e Naturalistic Intelligence
d. 64
e. A plant. Visual-Spatial Intelligence

-
¢
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Intrapersonal Intelligence

i. Good at communicating ideas and . . .
i. Can recognise their strengths and weaknesses.
thoughts.

ii. Good at non-verbal communication and

ii. Aware of their own emotional state and feelings
resolving conflict in groups.

and know how they can motivate themselves.

iii. Good at maintaining positive relationships ... : . . .
) gp PS i, Enjoy analysing theories and ideas.
with others,

5. a. Naturalistic Intelligence b. Interpersonal Intelligence
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Periodic Assessment-4
(Based on chapters 9to 11)

1. a.Input box b. Processing box ¢. Output box
2. name = "write your name " # Replace with your actual name

age = 25 # Replace with your actual age

address = "write your address" # Replace with your actual address
print("Name:", name)

print("Age:", age)

print("Address:", address)

3. a. Bodily-Kinesthetic Intelligence b. Logical-Mathematical Intelligence

p.
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Test Sheet-2

(Based on chapters 6to 11)

a. (iii) b. (i) c. (ii) d. (i) e. (iii)
f. (i) 9. (ii) h. ()

a. Algorithm b. Assembler c. External
d. Identifiers e. Interactive Mode f. Internet Banking
a. (F) b. (F) c. (M d. (T

. (This question was printed incorrectly in the book. Please correct it in your textbook.)

Question: e. Machine learning is a branch of Al and is based on the idea that machines can
be built to process data and learn on their own.

Answer: (T)

. A flowchart is the graphical representation of a process and the logic (which is also called an

algorithm) used in it.

. Markup language is a computer language that uses specific codes for formatting the layout

and style of a text file.

. Pythonis a high level object-oriented programming language. It is a general purpose language

with interactive features.

. Zoom offers the video conferencing option which is a live meeting held between two or more

geographically separated people.

. People who possess the qualities like being good at dancing and excellent hand-eye and

physical coordination.

. An interpreter reads one line of instruction at a time and translates it into machine language.

Any error in the instruction is reported immediately and the programmer can correct it
accordingly. It is slower than the compiler.

. The <HR> tag is used to divide the webpage into different sections by drawing a horizontal

line in the webpage. The thickness of the horizontal line is specified through the Size attribute
and the length is specified through the Width attribute in pixels or as a percentage. The
Color attribute is used to set the colour of the rule. The Noshade attribute makes the line
appear flat grey, giving a 2D effect to the rule.

. A Variable is the name of memory location that is used to store data values which can be

accessed or changed later. The names given to the variables are known as identifiers. In
Python, we do not need to specify the type of variable because Python is a dynamically
language and it also identifies the variable type automatically.

In Python, variables are declared and initialized at the same time in the following way:
a = 10
b = 20

N
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print (“a=", a)

print (“b=", Db)

On the output screen, a = 10andb = 20 will be printed.
d. To open Python IDLE Shell, follow the given steps:

@ Type python in search box.

@ Click on IDLE (Python 3.9 64-bit) option.
Components

Menu bar: It has various menus such as File, Edit, Shell.

Command Prompt: It allows the user to enter commands directly into Python and get an
output instantly by pressing the Enter key.

Control buttons: These buttons are used to resize and close the window.
e. To upload a file/folder on Google Drive, follow the given steps:

@ Click on the New option.

@ Click on Folder and select File upload or Folder upload option.

©® Navigate the folder and select the desired files or folders.

@ Click on Open button.

f. Plant. Visual-Spatial Intelligence

) W

p:
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